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Ćwiczenie 1. Edytor graficzny programu InTouch

Opracował: dr hab. inż. Sebastian Dudzik

1. Cel ćwiczenia

• Zapoznanie się z edytorem graficznym programu InTouch i menadżerem aplikacji (ang. Ap-
plicatiom Manager

• Zapoznanie się ze specyficznymi cechami edytora

• Praca z narzędziami graficznymi edytora

2. Wprowadzenie

Oprogramowanie aplikacyjne HMI (ang. Human Machine Interface) służy do graficznej repre-
zentacji przemysłowych środowisk wytwórczych. Narzędzia, materiały i procesy technologiczne
wykorzystywane przy wytwarzaniu produktu końcowego są odwzorowywane jako elementy gra-
ficzne ekranów aplikacji HMI. Operatorzy obiektów sterowania używają graficznych interfejsów
użytkownika do monitorowania i zarządzania procesem wytwórczym.

Program Application Manager jest używany do zarządzania aplikacjami InTouch. Środo-
wisko projektowania aplikacji WindowMaker zawiera zestaw narzędzi graficznych oraz innych
narzędzi projektowych, niezbędnych do budowy aplikacji programu InTouch. Do uruchamiania
aplikacji utworzonych z zastosowaniem programu WindowMaker służy program WindowsVie-
wer.

3. Przebieg ćwiczenia

3.1. Podstawowe operacje w programie InTouch

3.1.1. Uruchomienie programu InTouch i otwarcie aplikacji demonstracyjnej

1. W dalszej części ćwiczenia zostanie zaprezentowany sposób działania i obsługi aplikacji
programu InTouch. Uruchomić program InTouch wybierając Start»Wszystkie Progra-
my»Wonderware»Intouch

1
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2. Wyświetli się okno Application Manager:

1 – Tworzenie nowego projektu; 2 – Przejście do programu WindowMaker (otwarcie ist-
niejącego projektu w trybie edycji); 3 – Przejście do programu WindowViewer (otwarcie
istniejącego projektu w trybie uruchomieniowym); 4 – Opcje widoku elementów listy apli-
kacji Application Manager, możliwy wybór to: duże ikony, małe ikony, lista i szczegóły;
5 – Wyszukiwanie aplikacji na dysku (wyszukiwanie foldera); 6 – Lista aplikacji; 7 – Pasek
menu: operacje na plikach, podgląd, narzędzia i uzyskiwanie pomocy.

3. Otworzyć aplikację Demo Application 800x600, dwukrotnie klikając jej nazwę na liście
aplikacji. Jeżeli wyświetli się okno:

należy kliknąć przycisk Tak. Application Manager załaduje aplikację demonstracyjną i prze-
skaluje grafikę.

4. Wyświetli się okno wyboru okien do otwarcia:
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5. Zatwierdzić wybrane okna klikając OK. Aplikacja zostanie załadowana. W obszarze robo-
czym programu WindowMaker wyświetlą się wybrane okna.

6. Uruchomić aplikację demonstracyjną. W tym celu należy przejść do programu WindowVie-

wer klikając przycisk (Runtime) znajdujący się w prawym górnym rogu
okna głównego programu WindowMaker.

7. Zaobserwować działanie aplikacji w oknie Reactor Display:

8. Zaobserwować działanie aplikacji w oknie Main:

9. Zaobserwować działanie aplikacji w oknie Main

10. Kliknąć na przycisku Batch % Conc. u dołu ekranu w oknie Menu. Zmienić stężenie kon-
centratu w produkcie za pomocą przycisków i oraz suwaka (Slider):
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Ćwiczenie 1. Edytor graficzny programu InTouch ZTMAiPC

Nacisnąć przycisk OK aby zatwierdzić wprowadzone zmiany lub Exit aby zamknąć okno
%Conc. bez zatwierdzania zmian stężenia.

11. Kliknąć na przycisku Hist Trend:

W oknie wyświetlane są trendy historyczne. Przetestować działanie przycisków i suwaków.
Nacisnąć przycisk Defaults, aby wrócić do ustawień początkowych.

12. Kliknąć przycisk Conveyor. Zaobserwować działanie aplikacji w trybie automatycznym
(Auto).

Zmienić prędkość przesuwu taśmociągu za pomocą suwaka Speed control w prawej części
ekranu. Przełączyć aplikację w tryb ręczny klikając na przełączniku Auto/Manual po pra-
wej stronie ekranu. W trybie ręcznym Przeprowadzić cykl transferu beczki tak, jak odbywa-
ło się to w trybie automatycznym. Użyć klawisza Transfer i przycisku Ejector.

13. Wyjść z trybu uruchomieniowego klikając przycisk znajdujący się w prawym
górnym rogu okna głównego programu WindowViewer. Application Manager przełączy
aplikacją w tryb edycji w programie WindowMaker. Program WindowViewer pozostanie
otwarty.

14. Zamknąć program WindowMaker wybierając File»Exit.

15. Zamknąć program WindowViewer wybierając File»Exit.
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3.2. Utworzenie pierwszej aplikacji programu InTouch

3.2.1. Utworzenie aplikacji

1. Kliknąć na ikonę . Wyświetli się ono:

W polu tekstowym powinna się znajdować bazowa ścieżka dostępu do wszystkich apli-
kacji InTouch: ...\Public\Wonderware\InTouch Applications. Upewnić się,
że pole wyboru Set As Default Directory jest zaznaczone.

2. Kliknąć Dalej.

3. W polu tekstowym zastąpić napis NewApp nazwą katalogu aplikacji składającą się z dwóch
wybranych nazwisk członków grupy laboratoryjnej (np. KowalskiNowak):

4. Nacisnąć Dalej.

5. Wprowadzić nazwę i opis aplikacji:
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6. Kliknąć Zakończ. Wyświetli się okno Application Manager:

7. Kliknąć dwukrotnie na nazwie aplikacji Ćwiczenie 1 aby uruchomić program WindowMa-
ker. Zostanie otwarte okno główne programu WindowMaker

3.2.2. Tworzenie okna aplikacji

Aby zapoznać się z podstawowymi funkcjami i narzędziami graficznymi edytora programu
InTouch niezbędne jest utworzenie okna aplikacji. Aby utworzyć okno aplikacji należy wykonać
następujące kroki:

1. Kliknąć na ikonę (New Window). Alternatywnie można wybrać polecenie menu Fi-
le»New Window... lub nacisnąć Ctrl+N. Wyświetli się okno Window Properties

2. Ustawić parametry okna. W tym celu w polu tekstowym Name wpisać nazwę okna. W polu
tekstowym Comment wpisać komentarz. W polach Window Width i Window Height
wpisać odpowiednio szerokość i wysokość okna w pikselach:
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W obszarze roboczym programu WindowMaker pojawi się nowo utworzone okno:

3. Zapisać wszystkie okna aplikacji InTouch klikając na ikonie (Save All Windows) lub
wybierz File»Save All Windows.

3.3. Narzędzia graficzne

3.3.1. Podstawowe obiekty graficzne

Aby wstawić obiekt Rectangle (prostokąt) należy wykonać następujące kroki:

1. Z paska narzędziowego Draw Object Toolbar:

wybrać narzędzie Rectangle.

2. Klikając lewym przyciskiem myszy na oknie przeciągnąć prostokąt od lewego górnego rogu
do prawego dolnego. Położenie lewego górnego rogu rysowanego obiektu może być na
bieżąco odczytywana z pól X, Y znajdujących się w lewym dolnym rogu okna głównego.
Podobnie, szerokość i wysokość może być na bieżąco odczytywana z pól W, H. Ustalić
położenie i wymiary prostokąta jak na poniższym rysunku:

3. Używając kwadratowych uchwytów zmienić wymiary prostokąta: szerokość W = 100,
wysokość H = 100:
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4. Edytując pola W i H ponownie zmienić wymiary: szerokość W = 50, wysokość H =
150. Aby edytować wymiar należy kliknąć na polu wartości i wprowadzić z klawiatury
nową wartość.

5. Kliknąć na pustym obszarze okna aby odznaczyć prostokąt.

6. Zapisać wszystkie okna.

Aby wstawić obiekt Ellipse (elipsa) należy wykonać następujące kroki:

1. Używając narzędzia Ellipse z paska narzędziowego Draw Object Toolbar utworzyć
koło o promieniu 40 pikseli.

2. Przenieść koło klikając na nim lewym przyciskiem myszy i przeciągając go w nowe miejsce:

Aby utworzyć trójkąt należy wykonać następujące kroki:

1. Z paska narzędziowego Draw Object Toolbar wybrać narzędzie Polygon (wielokąt).

2. Kliknąć w pustym obszarze okna i przeciągnąć wskaźnikiem w dół i w prawo. Kliknąć
ponownie. Zostanie utworzony pierwszy bok trójkąta:

3. Przeciągnąć do góry i w prawo:
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4. Kliknąć dwukrotnie. Zostanie utworzony wypełniony trójkąt.

5. Przenieść nowo utworzony trójkąt:

Aby zmienić kolory obiektów graficznych należy wykonać następujące kroki:

1. Z paska narzędziowego Draw Object Toolbar wybrać narzędzie Select Mode (tryb
wyboru)

2. Zaznaczyć prostokąt klikając na nim wskaźnikiem.

3. Z paska narzędziowego Format Toolbar:

wybrać narzędzie Fill Color. Wyświetli się okno wyboru kolorów. Wybrać kolor czer-
wony. Kolor prostokąta zmieni się na kolor czerwony.

4. Kliknąć w pustym obszarze okna aby odznaczyć prostokąt.

5. Zmienić kolor koła na żółty, a kolor trójkąta na zielony:

Aby zmienić wzajemne położenie obiektów względem siebie należy wykonać następujące
kroki:
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1. Umieścić koło w środku prostokąta. W tym celu należy:

(a) Zaznaczyć koło (narzędzie Select Mode). Trzymając wciśnięty klawisz Shift kliknąć
prostokąt. Oba obiekty zostaną zaznaczone:

(b) Z paska narzędziowego Arrange Toolbar:

wybrać narzędzie Align Center Points. Kliknąć w pustym obszarze okna. Okno
powinno wyglądać następująco:

2. Utworzyć symbol z obiektów koło i prostokąt. W tym celu należy:

(a) Z paska narzędziowego Draw Object Toolbar wybrać narzędzie Select Mode. Klik-
nąć po lewej stronie koła i prostokąta ponad nimi. Przeciągnąć wskaźnik w dół i w pra-
wo aby objąć prostokąt i koło. Kliknąć poniżej obiektów po ich prawej stronie. Obiekty
są zaznaczone.

(b) Kliknąć prawym przyciskiem myszy na zaznaczonych obiektach. Z menu konteksto-
wego wybrać polecenie Cell/Symbol»Make Symbol:
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Zostanie utworzony symbol. Operacja tworzenia symbolu odpowiada operacji grupo-
wania obiektów graficznych.

(c) Kliknąć w pustym obszarze okna aby odznaczyć symbol.

3. Utworzyć nowy trójkąt i zmienić położenie trójkątów względem symbolu. W tym celu na-
leży:

(a) Zaznaczyć (dowolną metodą) trójkąt.

(b) Z paska narzędziowego General Toolbar:

wybrać narzędzie Duplicate Selection(s).

(c) Kliknąć w pustym obszarze okna aby odznaczyć nowo utworzony trójkąt:

4. Przerzucić nowo utworzony trójkąt względem osi poziomej. W tym celu należy:

(a) Zaznaczyć nowo utworzony trójkąt.

(b) Z paska narzędziowego Arrange Toolbar wybrać narzędzie Flip Vertical (prze-
rzuć w pionie).

(c) Kliknąć w pustym obszarze okna aby odznaczyć nowo utworzony trójkąt:

5. Wyrównać symbol i trójkąty. W tym celu należy:

(a) Zaznaczyć nowo utworzony trójkąt oraz symbol (koło i prostokąt).

(b) Z paska narzędziowego Arrange Toolbar wybrać narzędzie Align Top (wyrów-
naj do krawędzi górnej):
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(c) Nie zmieniając zaznaczenia z paska narzędziowego Arrange Toolbar wybrać narzę-
dzie Align Center (wyrównaj do środka w poziomie). Kliknąć w pustym obszarze
okna aby odznaczyć obiekty:

(d) Zaznaczyć górny trójkąt i symbol i za pomocą menu kontekstowego Cell/Symbol»Make
Symbol utworzyć z nich jeden symbol. Elementami symbolu mogą być inne symbole.
Kliknąć w pustym obszarze okna aby odznaczyć obiekty.

(e) Zaznaczyć wszystkie obiekty (jeden trójkąt i jeden symbol) za pomocą F2.
(f) Kliknąć Align Center. Kliknąć w pustym obszarze okna aby odznaczyć obiekty:

Trójkąt jest schowany za symbolem.
(g) Powiększyć część obszaru okna. Z paska narzędziowego Pan and Zoom Toolbar:

wybrać narzędzie Zoom In (powiększ)
(h) Kliknąć trzy razy w obszarze symbolu. Symbol i trójkąt za symbolem zostaną powięk-

szone.
(i) Wybrać narzędzie Select Mode. Kliknąć na symbolu. Z paska narzędziowego Arran-

ge Toolbar wybrać narzędzie Send To Back (przesuń na spód). Kliknąć w pustym
obszarze okna aby odznaczyć obiekty.

(j) Wrócić do podstawowej skali okna. Z paska narzędziowego Pan and Zoom Toolbar
wybrać narzędzie Zoom Normal (podstawowa skala):
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6. Zapisać wszystkie okna poleceniem Save All Windows

3.3.2. Operacje tekstowe

Aby dodać nowy element graficzny należy wykonać następujące kroki:

1. Używając narzędzia Rounded Rectangle z paska narzędziowego Draw Object Toolbar
utworzyć prostokąt o zaokrąglonych narożnikach.

2. Przenieść obiekt klikając na nim lewym przyciskiem myszy i przeciągając go w nowe miej-
sce:

3. Używając narzędzia Text z paska narzędziowego Draw Object Toolbar utworzyć napis:
Symbol.

4. Zmienić atrybuty tekstu. W tym celu należy:

(a) Zaznaczyć nowo utworzony napis
(b) Wybrać Text»Fonts z menu głównego.
(c) W oknie Czcionka wybrać Czcionka: Courier New, Styl czcionki: Pogrubiona,

Rozmiar: 12.
(d) Przenieść obiekt klikając na nim lewym przyciskiem myszy i przeciągając go w nowe

miejsce:
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(e) Utworzyć nowy napis: Operator. Właściwości tekstu: Czcionka: Arial, Styl czcion-
ki: Pogrubiona kursywa, Rozmiar: 14, Kolor: Czerwony.

(f) Przenieść obiekt klikając na nim lewym przyciskiem myszy i przeciągając go w nowe
miejsce:

3.3.3. Import rysunków w postaci mapy bitowej

Aby zaimportować rysunek z wykorzystaniem schowka systemu Windows należy wykonać
następujące kroki:

1. Uruchomić program Paint, wybierając Start»Wszystkie Programy»Akcesoria»Paint.

2. W programie Paint utworzyć prosty rysunek.

3. Przejść do programu WindowMaker bez zamykania programu Paint

4. Używając narzędzia Bitmap z paska narzędziowego Draw Object Toolbar utworzyć
prostokąt.

5. Klikając prawym przyciskiem myszy na utworzonym obiekcie typu Bitmap wybrać z menu
kontekstowego polecenie Paste Bitmap

Skopiowana z programu Paint bitmapa zostanie zaimportowana do obiektu Bitmap:
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Klikając prawym przyciskiem myszy na bitmapie wybrać z menu kontekstowego polecenie
Original Size. Zaobserwować zmianę rozmiaru.

6. Powrócić do poprzedniego rozmiaru naciskając Ctrl+Z (cofnij) lub wybierając Edit»Undo
Bitmap – Original Size.

Aby zaimportować rysunek z pliku należy wykonać następujące kroki:

(a) Przejść do uruchomionego programu Paint
(b) Zapisać rysunek w katalogu aplikacji programu InTouch w formacie *.jpg.

(c) Zamknąć program Paint. Przejść do programu WindowMaker.

(d) Z menu kontekstowego obiektu Bitmap (prawy przycisk myszy) wybrać Import Ima-
ge...:

Rysunek zostanie zaimportowany.

7. Zapisać wszystkie okna poleceniem Save All Windows.
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